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1 Introduction

1.1 Overview

EasyConnect Jaguar is latric System’s interface engine. The interface engine is middleware application that
can transform, route, clone, and translate messages. It provides effortless links between multiple
applications, such as Hospital Information Systems (HIS), physician offices, PACS systems, and many
more.

As shown in the table below, a single interface engine can play multiple middleware roles, serving as a
gateway, bridge, transformer bridge, or an intermediary.

Table 1-1: Interface Tasks and Roles

Interface Task Middleware Role

Perform business rules and application level Gateway.
responsibilities.

Transform from one value to another. Bridge/Transformer Bridge.

Transform from one protocol to another. Intermediary.

With EasyConnect Jaguar, you can:

e Develop, test and deploy healthcare interfaces in just a couple of hours, not days or weeks.

e Create interfaces on your own or use latric Systems Interoperability/Integration experts to create and configure
them for you.

e Share clinical data with regional Health Information Exchanges (HIEs) easily and cost-effectively.

e Strengthen relationships with physician offices and other hospital departments with fast and reliable data
exchange.

e  Proactively monitor interfaces with latric Systems i-alert function: You can detect and solve interface issues even
before end users report them.

e Prevent downtime and data loss by monitoring via a centralized dashboard instead of individually monitoring
point-to-point interfaces.

e Utilize iForum (an online community forum for connecting with other EasyConnect Jaguar users and latric
Systems support team) to get answers to all of your questions quickly.

EasyConnect Jaguar also includes the following benefits:

e Registered with the FDA as an MDDS Class 1 device.
(Class 1 device: A computer- or software-based system that stores, transfers, displays, or reformats patient
medical data, but does not provide any diagnostic or clinical decision-making functions.)

e  Ability to download and install client software.
e Centralized status board.

e Event and performance monitors.

e Scalable to meet IT growth.
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1.2 Tool Tips

To learn more about the purpose of an icon, menu item, or other element of EasyConnect Jaguar, place a
mouse cursor above it. Tool tips will appear in a small pop-up window, as shown in Figure 1-1.

) [show Status Board for Selected Engine Instance

Figure 1-1: Sample Tool Tip

1.3 Help Menu

See Figure 1-2. From the Help tab, you can access information about the following topics:

Check for Updates: See if a new revision of the software is available.

User Manual: Access the most recent support documentation.

Add In Templates: Q: tdb as of 10-19.

About the Engine Client: Display information concerning the version number and date of the engine client.

=2 FasyConnect Jaguar Client

File View | Help

Check For Updates |

IUser Manual
Add In Templates

About the Engine Client

Figure 1-2: Help Menu

1.4  Engine Groups

The Engine Groups feature lets you assign and manage different engine instances. (Although this feature
is not required for setup, Engine Groups helps organization when dealing with more than one engine
instance.) See Figure 1-3, Figure 1-4, and Figure 1-5.

1. Select File -> Preferences

T T T —
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= FasyConnect Jaguar, Client

Figure 1-3: File -> Preferences

2. Inthe Preferences window, select the Manage Engine Groups tab.

=2 Preferences

Manage Engine Groups

Assign Engine Groups

CLTe01
CLTe24

Figure 1-4: The Manage Groups Tab

3. Select the Assign Engine Groups tab,

=2 Preferences

Manage Engine Groups | Assign Engine Groups

I

Cancel

P —

Figure 1-5: The Assign Engine Groups Tab
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2 Installing EasyConnect Jaguar Instance(s)

2.1 Installation

Four installation steps are used to install an EasyConnect Jaguar Client. (See Figure 2-1, Figure 2-2,
Figure 2-3, and Figure 2-4.)

i EasyConnect Jaguar Client

The ingtaller will guide you through the steps required to install EagyConnect Jaguar Client on pour
corplter,

WARMIMG: This computer program is pratected by copuright law and intemational treaties.
Unautharized duplication or distribution of this pragram, or any portion of it, mag result in severs civil
or criminal penalties, and will be prosecuted to the maximum extent possible under the law,

Figure 2-1: The Welcome Screen

i'-.?* EasyConnect Jaguar Client

The installer is ready to install EasyConnect Jaguar Client on your computer.

Click "Mest" to start the installation.

[ Cancel J [ < Back J I_ Mext >

Figure 2-2: Confirm Installation
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i EasyConnect Jaguar Client

The installer will install EasyConnect Jaguar Client to the following folder.
Ta install in this folder, click "Mext". To install to a different foldes, enter it below or click "Browse".

Folder:

iC:\ng:am FilesMatiic Systems\E asyConnect Jaguar Clhenth | Browese. .. ]

[ cancel ][ <Back || New> |

Figure 2-3: Select Installation Folder

EasyConnect Jaguar Client

EazyConnect Jaguar Client iz being installed.

Pleaze wait...

Figure 2-4: Installing the Client
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Following successful installation, the following shortcut icon will appear on your desktop. See Figure 2-5.

Figure 2-5: EasyConnect Jaguar Client Icon

2.2  Register Engine Instance(s)

You can register a client engine instance if it is TEST, LIVE, or both.

¥ EasyConnect Jaguar Client LA R L »
File. Wiew Help

ine Explorer '~ X Native Interfaces ' Home Page
S E -

Register New Engine Instance

Helpful Links

Figure 2-6: Register Engine Instance

Steps to register a new engine instance:

1. Install client.
2. Double-click on downloaded client after install to open EasyConnect Jaguar Client.
3. Asshown in Figure 2-6, click the appropriate icon to register the Engine.

=7 Register Engine Instance E

I Engine Server Elncalhost I

Engine Group | v

Engine Instance © Test & Live

Engine Username |ﬂdﬂ“ﬂ

Engine Password |"'“

Cancel |
Figure 2-7: Register Engine Instance
D a———
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4. As shown in Figure 2-7, complete all fields on form:
a. Engine Server: IP of local copy of the engine
b. Engine Instance: Test or LIVE
c. Engine Username
d. Engine Password

5. Click OK.

2.3  Unregister Engine Instance(s)

& EasyConnectJaguarClient TR W &= &

Help

X' NativeInterfaces "Home Page |

= —

AUl Unregister Selected Engine Instancej

I Helpful Links

Figure 2-8: Unregister Selected Engine Interface

Steps to unregister an engine instance:

1. Open EasyConnect Jaguar Client.
2. As shown in Figure 2-8, click the appropriate icon to unregister the Engine.
3. Atthe prompt "Are you sure you want to remove this registered engine instance?" select YES.

2.4  Connect to Engine

=2 EasyLConnect Jaguar Client

File View Help

Engine Explorer w 0 X

8 RN B I'"'!E
< LIVE on localhnaet
£ 3 Connect

Figure 2-9: Connect to Engine

Steps to connect to engine:

1. Right-click on registered engine in Engine Explorer.
2. Select Connect.
3. When prompted, enter your engine login credentials.

Note: Ifthe engine instance has already been set up, you will see it in the list in the Engine Explorer. Right
click on it and select Connect.

——————— ]
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3 Engine Settings

3.1 Engine License
To view engine license information:

1. In Engine Explorer, right-click on the registered engine, then select Settings. See Figure 3-1.

& EasyConnectJaguarClient 0 % W W = %

File View Help

tlew mm | —
4 3 UVEon197-znese — o
I [l Interfal *7 ault
I' [ Dictiorl g% kmmg yful Links
[ [ Extern
|
[

[ Manag [£5] Status Board

LA Securit md User Preferences justems Inc.
" B Disconnect Systems Integration Sen

Figure 3-1: Selecting the Settings Tab

As shown in Figure 3-2, the License tab will appear.

& Settings: LIVE on 192.168.0.51 R=SREa X

License |System Alerts | SMTP | Purging | Monitoring | Security | RLS | Legacy | Engine Version

Licensed To latric Systems

License Key F83E0-96FAC-12E45-03394-47446

latric Supported |/

Figure 3-2: The License Tab

Information under the License tab includes the name of the license holder, the license key, and a checkbox
indicating that latric Systems supports the engine and interfaces.
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3.2 Systems Alerts

r
€ Settings: LIVE on 192.168.0.51

Site Code 1AT

iAlertID 1234

Local Alert Group |ITAdmin
[l DEFAULT

Figure 3-3: The Systems Alert Tab

Under the System Alerts tab, the Site Code is an ID provided by latric Systems. The iAlert ID is also
provided by latric Systems for support purposes. The Local Alert Group specifies the local group to be used
for system alerts.

3.3 SMTP

& Settings: LIVE on 192.168.0.51

Server
] Port 25
| Use S5L g
Username
|
Password G
| Email Address -

Figure 3-4: The SMTP Tab
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Information found under the SMTP tab is summarized in the following table.

Table 3-1: The SMTP Tab

Tab Entry Significance

Server Specifies the SMTP server used for local email
notices and alerts.

Port The port hosting SMTP service on the SMTP
Sserver.

Use SSL (checkbox) When checked (enabled), this feature indicates
that SMTP communications will be encrypted
using SSL.

Username The name assigned to a user by the system
administrator.

Password The password used to access SMTP service.

Email Address In email notifications, the address used in the
"From" field.

3.4  Purging

Bl License | System Alerts | SMTP | Purging | Monitoring | Secunty | RLS | Legacy | Engine Version

Audit Purge Days 30

Audit Purge Time  12:10 AM

| Event Log Purge Days 7

| Event Log Purge Time 12:15 AM
External Int Magrs Purge Days 7

l

External Int Mgrs Purge Time 12:45 AM

f Interface Logs Purge Time 12:35 AM

i Status History Purge Time 12:25 AM

Figure 3-5: The Purging Tab

- — - o
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Information found under the Purging tab is summarized in the following table.
Table 3-1: The Purging Tab

Tab Entry Significance

Audit Purge Days Audits older than the number specified will be
purged daily.

Audit Purge Time The time of day audits will be purged.

Event Log Purge Days Events older than the number specified will be
purged daily.

Event Log Purge Time The time of day events will be purged.

External Int Mgrs Purge Time |External interface manager data that is older
than the number of days specified will be
purged daily,

Interface Logs Purge Time The time of day interface logs will be purged.

Status History Purge Time The time of day the component status history
will be purged.

3.5 Monitoring

 License | System Alerts | SMTP | Purging  Monitoring | Security | RLS | Legacy | Engine Version |

Performance Monitor Interval 30
Performance Monitor Duration 60
| Alert Buffer Minutes 10

CPU Alert Threshold 99
Hard Disk Alert Threshold 1

RAM Alert Threshold 1

Figure 3-6: The Monitoring Tab

]
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Information found under the Monitoring Tab is summarized in the following table.
Table 3-1: The Monitoring Tab

Tab Entry Significance

Performance Monitor Interval | The number of seconds between system per-
formance data logging iterations. To disable
performance data logging, set this number to 0.

Performance Monitor Duration: | The number of minutes to keep performance

statistics.

Alert Buffer Minutes The number of minutes an abnormal perfor-
mance condition must persist before an alert is
sent.

CPU Alert Threshold If CPU utilization exceeds the percentage

defined here for more than ten minutes, an
alert will be sent.

Hard Disk Alert Threshold If the amount of free space on any hard disk
drops and remains below the percentage
defined here for more than ten minutes, an
alert will be sent.

RAM Alert Threshold If the amount of RAM available drops and
remains below the percentage defined here for
more than ten minutes, an alert will be sent.

3.6  Security

—

EFSeﬂmgr; : LIVE on 192.168.0.5

License | System Alerts | SMTP | Purging | Monitoring | Security | RLS | Legacy | Engine Version

Session Expiration 15

Active Directory Domain

Figure 3-7: The Security Tab

Information found under the Security Tab includes:
Session Expiration: After the number of minutes specified herein, sessions with no activity will time out.
Active Directory Domain: This field contains active directory domain information.
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License | System Alerts | SMTP | Purging | Monitoring | Security| RLS | Legacy | Engine Version

*

License Key
Data Location iof
SQL Server
Database
Username

Password

Figure 3-8: The RLS Tab

Data fields in the RLS tab (see Figure 3-8) include:

License Key: Provided by latric Systems to enable Record Locator Service for this installation.
Data Location: Folder where the Record Locator Service will look for files to process.

SQL Server: SQL server instance hosting the Record Locator Service Database.

Database: Name of the Record Locator Database.

Username: The SQL Server login for the Record Locator Service database.

Password: The password for the SQL Server login for the Record Locator Service database.

3.8 Legacy Settings

[/ Settings: LIVE on 1021600, 1 N 5o e

License | System Alerts | SMTP | Purging | Monitoring | Security | RLS | Lega<y |Engine Version

-

IDP Integration Enabled ]

1DP Data Folder DAEC)

Figure 3-9: The Legacy Settings Tab

Information found under the Legacy Settings Tab includes:
IDP Integration Enabled: When checked, IDP integration is enabled.
IDP Data Folder: Specifies the location for IDP data and executables.

e ————— ]
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4  Security

4.1 Users

The security administration feature facilitates management of authorized engine users and the interfaces
that users are allowed to view or control. The security administration feature is available only to system
administrators.

' & EasyConnect Jaguar Client

Help

& 2@ E '_’4‘”

4 < LIVE on 192.168.0.51
I [ Interfaces
I [ Dictionaries
I [ External Managers
L Ma

U User Access Levels

[J Users

Figure 4-1: Accessing the Security Feature

Users User Access Levels  Home Page. - %
ll Level Mnemonic Level Description |
| e ,

E  Analyst Analyst |

& Help Desk Help Desk

= Management Management

& Administrator Jaguar Administrator

& Lead Lead

® b [EENG [nterface Enginesr

B MR Medical Records

Figure 4-2: User Access Levels

To create an engine user, follow these steps:

1. Place the cursor in the Level Mnemonic column.

2. Define a user access level mnemonic.

3. Place the cursor in the Level Description column and define a level description.
4. Save the information by pressing the Enter key.

After creating an engine user, you will also need to define three levels of access: Access Type, Access
Mode, and Access Item, as shown in the next three figures.

L T ——————————
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User Access Levels Users  Home Page R
Level Mnemaonic Level Description
!Gi
+  Analyst Analyst
+ Help Desk Help Desk
+ Management Management
+ Administrator Jaguar Administrator
+ Lead Lead
= I_E_ENG Interface Enginesr
Access Type ~ Access Mode Access [tem Item Name -
" | ~
[External Interface Mananger
Interface
Item
Level
Figure 4-3: Access Type
G o
nemonic |
"
& Analyst Analyst
& Help Desk Help Desk
B Management Management
& Administrator Jaguar Administrator
@ Lead Lead
=] IEENG Interface Engineer
| Access Type | Access Mode Access ltem | Item Name
%3 | Interface ~ | -
Interface Full Access ADT from HIS System
None
Interface Pedro's Test
Ttem - Data Format HL7 2.x
Figure 4-4: Access Mode
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Gl s Pecess Leveh Gl -
R
® Analyst Analyst
(] Help Desk Help Desk
(] Management Management
2] Administrator Jaguar Administrator
] Lead Lead
= IEENG Interface Engineer
Access Type TAccess Mode | Accesstem | ltem Name
% | Interface * None -
Interface Full Access ADT from Demo site -
Interface Full Access ADT from MEDITECH -
Item Full Access ADT from Mediech LIVE
B o Conditional Interface

Figure 4-5: Access ltem

4.2  Adding Access Level to Users

. Uses Access Levels  Users | Home Fage | - x
N Y — VT *
i :s‘

| 4.ﬁ.ddeUseri

Figure 4-6: Add a New User

1. To add a new user, click the appropriate icon under the Users tab. See Figure 4-6.
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